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ACROBAT READER SCREEN DISPLAY
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O Cowver
0 Impartant
[ Fareword TAELE OF CONTENTS
[ Table of Contents Generl Information
D Section 04 R IION - .
i Maintenance and Lubrication
O Section 0B
O Section 14 HEATING AND Haater and Vertiaton
D) Section 15 AIR CONDITICNING ‘At Condiioning
O Section 3 Stearing, Suspension, Wheels and Tires
[ Section 34 Wheal Alignment
O Section 36 Manual Rack and Finion
O Section 381 STEERING, SUSPENSION, Electrical Power Stearing (F/S) System
O Section 3C WHEELS AND TIRES Stesring Whee! and Column
D Section 3D Frant Suspension
O Section 3E
[ Section 3F Rear Suspansion
[0 Section 46 Wheel and Tires
[ Section 5 DRIVE SHAFTS AND PROPELLER SHAFT | Propeller Shaft
[ Section 5E Brakes System
[ Section & BRAKE SYSTEM Anti-lock Brake System (ABS)
[ Section 64 Engine
O SECt!Dn 66 Enging Mechanical
O Secl!nn EC Engine Cooling
[ Section GE e Foel
O Section 6F i __
[ Section GG Engine and Emission Canénol System
[ Section 6H Ignition System
[ Section BE Cranking Systam
[ Section 74 Charging System
[ Section 7C Exhaust System
[ Section 7F Manual Transmission
[ Section & TRANSMISSION, CLUTCH Clutch
[0 Section 84 AND DIFFERENTIAL i
) Ciarantial
O Section 4 P—
. rical Systam
O Section 10 ELECTRICAL SYSTEM
0 Section 10E Wiring Cagram
BODY SERVICE
Rastraint System
RESTRAINT SYSTEM
A Bag Systern
NOTE:
The screen loned SECTION BA WIRING DIAGRAM above s not contained in this manual.
The BECTIGN BA Is contained in WIRING DIAGRAM MANUAL in the table on the previous page.
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1 | Page only display Only a page is displayed on the entire screen.

2 | Bookmark and page display | A bookmark is displayed in the left of the screen
and a page in the right.

3 | Thumbnails and page display | Thumbnails are displayed in the left of the screen
and a page in the right.

4 | Hand With the button clicked in advance, move the
pointer to the position where the link can be used,
and the pointer will change. Clicking there will make
the page to be linked be displayed.

5 | Zoom In/ Zoom Out Click where you want to have magnified. For size
reduction, click while pressing the “Option” for Mac-
intosh and “Ctrl” for Windows.

6 | Select Text You can select the text. (The text can be selected
on the other application program by using the copy
& paste functions. If you want to use graphics,
select “Select Graphics” in the “Tools” menu. It
enables you to edit easily on the other application
program by specifying the range for movement and
using copy and paste functions.)

7 | First page display The first page is displayed.

8 | Previous page display The page immediately before is displayed. The [ T ]
and [ « ] key has the same function.

9 | Next page display The page immediately after is displayed. The [ | ]
and [ — ] key has the same function.

10 | Last page display The last page is displayed.

11 | Go Back The page which was on display before the current
one is displayed.

12 | Go Forward The pages after the one displayed by “Go Back” are
displayed.

13 | Actual size display The display scale is set at 100%.

14 | Fit page The scale is set so that the entire screen is used for
display.

15 | Fit width The scale is set so that the width of the screen is
used fully for display.

16 | Find Enter the word you want to retrieve in “Find What: ”
and click on the “Find” button. Then the retrieved
character will be highlighted. To repeat the retrieve
function, press “Command” and “G” keys for Macin-
tosh and “Ctrl” and “G” for Windows.

17 | Bookmark Clicking on the header will make the corresponding
page (section) be displayed.

18 | Page specify You can specify the page you want an display.

19 | Display scale You can change the display scale.

20 | Paper direction and paper The direction of the paper and its longitudinal and

size

lateral dimensions are displayed.




HOW TO READ MANUAL DATA

1. By opening (i.e. double-click the icon) the “TOP.pdf” file on CD-ROM, the Acro-
bat Reader is automaticaly booted and the title screen shown below.

Example:

SUZUKI

I S =T/ = A =B = E ) = & D =™ =

SERVICE MANUAL

2. Click on the title screen then, the Manual List displays below. From the list,
select the number assigned to the manual to be displayed and click the part

number.
Example:
Part Number Language Manual Name
99500-65D00-01E E

99500-65D00-01F

99500-65D00-01G

99500-65D00-01S

F
G
S

SQ416/420/625
Service Manual




3. Then, the “Important” page of each manual displays. At the same time, a “Book-
mark” frame also displays on the left side of the screen.

Example:

“Important” page

/

BHS E K« r «» OO0 B
ErESaEA TN »
[ Manual List = =
[ Cover
D Foreword WARNING/CAUTION/NOTE WARNING:
Please read this manual and follow s insructions . . o
D Tahle of cantents carglully, To emphasize special information, the ::;Imlnl[.lb ;ag;ts'\lll:‘r.:lm & Bupr
D Section 0A words WARNING, CAUTION m-fd NOTE have spe- # Service on and around tha air bag system
D Section 0B u.ajn.'eannge. Pays{gcmlﬂbaﬂtmnlnlhsmsssagas comporents of Wiring must be performed
_ highlightad by these signal words. anly by an sutherized SUZUK| dealer.
DSECNDH']P« o . . Reter 1o “Air Bag System Components and
: WARNI Wirlng Location View™ under “General De-
D SECt!Dn 18 Indicales a potential hazard that could result scription” in air bag system section in order
D Section 3 In death or injury. to confirm whether you are pertorming ser-
i T vice on of near the air bag eyetem compo-
D SECtIDn SA - TS U Wi . P it ol v sil ViR R
Section 381 CAUTION: INGS and “Sarvice Precautions” under "On-
D . Indicates a potential hazard that could result Vehicle Service” in air bag system section
D Section 3C1 in vehicle damage. before performing service en or arcund the
D Section 3D . air bag system components or wiring. Fail-
Section 3E NOTE: ure to fellow WARNINGS could result in
D . Indicates special information to make mainte- mln:nlln:ux::ﬂmillun _ﬂ “.:a;mE':h:
D Section 3F nance easler or instructions clearar. could ren “_‘ om ineperative,
. ef these twe conditions may resull in severe
[ Section 442 injury.
D Section 48 *It the &lr bag system and another vehicle
. aystemn both need repair, SUZUKL recam.
D Section 5 mends that the air bag system be repaired
D Section 54 | | first. to help aveid unintendad air bag sys-
- tern activation. -
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“Bookmark” frame



4. Click (left-button) “Foreword” in the Bookmark and “Foreword” page displays.

Example:

“Foreword”

yd

Important” page
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[ important IMPORTANT
Pl 00 2 monas o 1 eciors | VAPHNG:
ase i man nllow its insdr E hich with ital
D Tahle of contents carefiilly, To emphasize special information, the a:'ﬂm.m (Air B""’"'s“"m: # Bupp
D Section 0A words WQMI;G,GAU‘I'IDN and "aT_IE have spe- # Service on and around the air bag system |
D Section 0B cal meanngs. Pay special attention 1o the messages commponents of Wiring must be pertormed
0} Section 14 highlighisd by thess signal words. anly by an sutharized SUZUKI dealer.
ection - - Refer to “Alr Bag System Components and
D Section 18 WARNING: Wiring Location View™ under “General De-
) Indieales a potential hazerd that could result sCription” in air bag system sectien in order
D Section 3 In death or injury. to confirm whether you are pertorming ser-
- T - viee on ef near the alr bag syetam compe-
D SECIIDI"I BA _— - TS U Wi . P it ol v sil ViR R
[} Section 381 CAUTION: INGS and “Sarvice Precautions” under "On-
i Indicates a potential hazard that could result Vehicle Service” in air bag system section
D Section 3C1 in vehicle damage. before performing service on or eround the |
D Section 20D air bag system compaonants or wiring. Fail-
ure to fellow WARMNINGS could result in
Section 3E NOTE:
D . Indicates speclal Information to make mainte- ml“:""“::ﬂ?"‘:“ _d ““Pa;va':H:
D Section 3F nance easler or Instructions clearar. could ren “_' e ineperative.
D Section 442 ef these twe conditions may resull in severe
injury.
D Section 48 & the alr bag system and another vehicle
D Secti 5 aystemn both nead repair, SUZUKI recom-
ection maends that the air bag system be repaired
D Section 5A — | first, to help avoid unintended air bag sys-
l tem activation. -
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[ Cover =
[ Important
FOREWORD
D Tahle of contents Thia manual {Velumes 1 and 2} contalns procedures for diagnoale, malntznance, adjusiments,
Sacti i miner service cperations, replacement of components (Sendee) and for deassembly and as-
D ection sembly of majer components (Unit Regalr-Crearhaul).
Section 0B
D Secti 14 WOLUME 1 containg Chasels, Electrical and Body sactions (all sections except engine).
D ectian WOLUME 2 containg Engine aections (Sections & — 6K).
[ Section 18 Applcable modst I
- jcable model: 2000 16/
[ Section 3
D Section 34 The contents are claselfied into sections sach of which |5 given a section number as Indicated
. in the Table of Contents on nextpage. And on the first page of each individual sectien is anindex
[} Section 381 of that esetian,
D Section 301 Thia manual sheuld be kept ina handy ploce for resdy referance of the aervice work.
) Sarict obaervance of the e speciiied items will enable one to obtain the full performance of the
[ Section 30 vehicla.
D SBCI!DI"I 3E ‘When replacing parts or servicing by dizassembling, itis recommended to use SUZUEK genuing
D Section 3F parta, toole and service materials {lubricant. esalants, etc.} &s specified in each description.
D Section 442 Al information. lusirations and specificatiens contained in this literature are based on the latest
D Section 4B preduct information avallable at the time of publication spproval. And used as the main subject
Seci 5 of dascription |s the vehicle of standard apecifications amaeng others.
D ectian Theredore, note that llustrationa may differ from the vehicle being actually serviced.
D Section 54 (- The right ks resarved 1o make changea at any tme without notice.
- -
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5. Click (left-button) “Table of Contents” in the Bookmark, “Table of Contents”
page displays.
Example:

,Table of Contents” _‘Foreword” page
RS E K fr «» OEO

[ a9 gaz—n g |» >
[ Cover =] -
[} Important
D Foreword FOREWORD
D able of contents: This manual {Velumes 1 and 2} containg Ll for I adjustments,

Secti i minoe servics replacement of (Service) and for dsassernbly and as-
D ection sembly of major componenta {Unit Repalr-Crverhaul).
[} Section 0B
Sacti 14 WOLUME 1 contalne Chassls, Electrical and Body sections (all sections except engine).
[ section VOLLME 2 containg Engine sections (Sections & — 6K).
[ section 18 "
: rnodel: 2000
[ Section 3
D Section 34 The cententa are classifled info sections each of which I given a section numer as Indicated
. In the Table of Contents on next page. And an the first page of esch indiidual section s an index
[ Section 381 of that ssction.
D Section 301 Thig manual should be kept in a handy plocs for resdy reference of the service work.
K Strict observancs of the so specified iberms will enable one to obtain the full performance of the
[ Section 300 wehice.
[} Section 3E

X ‘When replacing parts or senvicing by disassembling, itls recommended to use SUZUK] genuine
D Section 3F parts, tools 2nd service materisls [ubricant. eealants, stc.} as epecified In sach deecription,

[ Section 4A2

Al i Inthia literature are based on the latest
D Section 4B product infarmation avallable at the fime of publication spproval. And used as the main subject
Sact 5 of description |s the vehicle of standand specifications among others.
D ection Theretore, note that lustrations may differ from the vehicle being actially serviced.
D Section 54 The right ks regerved 1o make changes at any time without notice,
[} section 58 RELATED MANUALS:
[ Section 5C Wanual Name Wanual No.
D Section 5E 50416/ 50420/ 53625 Unit Repalr Manual 28501-85000
. for Manual Tranamiaslon. Automatie Transmission,
[ Section 74 Transfer and Diftersntial.
D Section 781 1899 5041 6/ 50420/ 50625 Wiring Diagram Manual 99512-85000
[ Section 71
D Section 7D SUZUKI MOTOR CORPORATION
D SECliDn ?E /é OVERSEAS SERVICE DEFPARTMENT -
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[ Important
[} Foreword
[WErable of contents
Section 0A
D . Malntznancs and Lubrication
[ Section 0B HEATING AND AR
[] Section 14 COMDITIONING |
. Heater and Ventilation 1A
0 Section 18 AiEsedisang™ T 6
[ Section 3 STEERING, SUSPENSION, s
[) 5ection 34 y:_naal_anun TIRES
[) Section 381 B
D Section 3C1 'ﬂzéég_sﬁérfnh_%éél _____ 201
Ay umn
[ Section 30 T
[ Section 2E TTEE
D Section 3F Wheel and Tires 3F
A DRIVE SHAFT/PROP, SHAFT
() Section 442 Front Orive Snagnatt | o
() Section 48 Bearng ONSea | 77|
. Propeller Shaft 48 TRANSMISSION, CLUTCH
[ Section & BRAKES 5| | mooirenenal
D Section 54 | ‘Braka Pipe_.'H-nm;fh;la:;har """"""" Manual Transmisslon {Type 1}
- Gyinder 5% | | “ianial Tiansrisdin fiyps | a1 -
1] [ B[ & [ & el sz% [w][W]4] z/792 [+]M]] 1958 x2vas zu [O] 4 » |7

e To jump to a reference manual
On the “Foreword” page, the link is pasted from manual name and manual part number
of the “Related Manuals”. Click (left-button) in the appropriate link jump to that related
Service Manual.

(Linked at the location, at which the pointer “ - ", {-j-l or {""Fu changes to “ {I-:, ")



6. Perform the following procedure ((1) or (2)) to jump from “Table of Contents”
page to first page contents of a section.
(1) Click (Left-button) in the appropriate link jumps to that section (Linked at the loca-

tion, at which the pointer “ . ”, “(&, " or “4™" changes to “ <k, ")

(2) Clicking the section name or page name inside the “Bookmark” frame jumps to
that section.

Example:

“Table of Contents” page

() (1)

H5B& E K« /e» OO0 #
| tBY9 gaz- SHR .
[ Cover = =
[ Irnportant
[ Fereword EM s
[ Table of contants GENERALINFORMATION | | |ENGINE = | | El -
i Seneralintormaten L L = &
D SECt?Dn 0A Maintenanca and Lubrication 1] -and Diagnogle(S AL R B “ 24
[} Section 08 HEATING AND AR 6h2
[ Section 14 COMDITIONING 6A4
Heater and Yentilation
” “Alr Sendificning” T ;]
[) Section 3 STEERING, SUSPENSION, o
() Section 34 WHEELS ANDTIRES
: Front End Algnment o=
D Section 381 Power Stearing (FrS) System
[} Section 3¢ Alr Bag Stesng Whee! T
" and Column &F1
[} Section 30 Front Sisperaion’ T o2
[ Section 3E Fear Suegension T
[} section 3F hes and Tires yaiem &a
Sactian 442 DRIVESHAFT/PROPSHAFT| [ | WEECEE o]l conead “ 6H
[} Section Erant rive Shaft/ Shait P Chargng System " T[T~ o
[ Section 48 Beaing OlSed | 7 | Edhaust Sysiem o | I =
. Propeller Shaft 18 TRANSMISSION, CLUTEH “
[ Section 5 BRAKES 5 | | ANDDIFFERENTIAL | |
D Section 54 ‘Broke Pipe/HoseiMaster | .| Manugl Transmission [Type 1} TA ﬂ
[} Sestion 58 Cylinder | B | | Mania ez e 2 [ AT “
o Frniad 877 | Mo aninaion | 61|
[ Section Ferking and Rsar Braiee "1 77867 | | Ghash pyarauie Typs) | [ e ]
() Section 5E Antlock Brake System(Type 1)|  SE__ [ [ Transter m
D Section 7A Artilock Broke System {Type 2) | 5E1 " Diffaréntial Fronfl” """ T[T TE |
Section 781 " Ditferantinl Fear) T[T 7
0 sec fon BODY ELECTRICAL SYSTEM|  ©
[} Section 7
DSection 7D _Llghting System | . 88 _| 8A
[ Section 7E rsirumaniaton’ iiver w©
i “Windowe, Mirers, Secaity ||
] Sect!un TF Wiodows L .
D Section 2 "Crige Confrol System [ ]
[} Section 88 BODY SERVICE ?
[ Section &C RESTRAINTSYSTEM | o
. Saat Balt 104
() Section €D i e Sysien [ e
[) Section 8E
] NOTE:
D Section 9 The screen loned Sections 6 — 6K are included in Violume 2 and Section A s in Wiring
D Section 10 Disgram Manual mentioned in Foreword of thiz manual.
[ Section 104 |
- -
1] B[R [ @ [ sz= [=][4[4] zr792 [r[M]] 1358xzrea zu [O] ¢ » [




7. From here on, the following operations can be executed. Select the appropriate
operation according to your needs.
* To jump to a page that contains a title
Jump to the first page of each section, on which linked to the page that contains each
title. Click (left-button) in the appropriate link jumps to that page that contains the title.

(Linked at the location, at which the pointer “ . *, {-}l or {"FF: changes to {I-P "))
* To go back to the previous screen status

Click the “| 44| button on the menu bar of the Acrobat Reader to the display status

that was shown before the currently display.
e To jump to the next page

Click the 3 ” putton on the menu bar of Acrobat Reader.

* To jump to the previous page

Click the “ 4 ” putton on the menu bar of Acrobat Reader.

* To enlarge the text on the screen as characters are too small to read

Select the {-j-l ” button (zoom tool) and then click in the area in which the pointer

“ E ” changes to {-}l ” (within the page display area).
* To decrease the size of the screen

Select the “ @{ ” button (zoom tool) and then move the pointer to the area in which the

pointer “ * ” changes to {-j-l ” (within the page display area).
Holding down the [Ctrl] key (or [Option] key) on the keyboard (in which case, the
pointer {-j-l ” changes to El "), Click (left-button).
* To display the contents of one full page
Click the button on the menu bar of Acrobat Reader.



e To print the data
(1) On a specific page or pages:
Refer to the page number (“B”) given on the bottom of the screen and take note of
it. Select “Print” (“A”) in the File menu and specify the page number(s) to be
printed.
(2) On all pages:
Select “Print” (“A”) in the File menu and select “All” for the page range.

Open.. #®0
Close 3 dl[ha1lds

Oc{ Ducument Info »

0 I tup. <P
“A” DE( Print.. %P
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